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|. About Choices

Choices helps students and career center clients implement education and
career plans with connections to schools, job banks, tools for writing
resumes, practicing for interviews, and planning a career search.

Users get comprehensive and easy-to-use databases for occupations,
colleges, and financial aid resources. Validated assessments support self-
directed exploration and planning.

I-1 Getting Started

This documentation contains instructions for using Windows and Macintosh
versions of Choices.

-2 Optional Add-Ons for Choices

eChoices and the Career Aptitude Survey (CAS) component are optional
products purchased separately. If you have a license for the CAS component,
you can install it from the Choices CD-ROM. If you have an account for
eChoices, you may use Choices to import and export sessions to and from
eChoices.

1-2-1 State- and Region-Specific Data

When installing Choices you will be prompted to install the National or
National and State Specific data for Choices. At the time of production,
available state or regional information will be included on the National CD-
ROM and the remaining state information will be located at:

U.S. http://www.bridges.com/

Canada http://www.bridges.com/canada/
Click Product Updates under the Support section. In some areas, you may
also be mailed state or regional information to add to the National database.

1-2-2 Screen Reader Support

Choices supports third-party screen reader applications (such as JAWS) for
the visually impaired. When installing Choices, at the Select Program Folder
screen you will notice a checkbox option to “Include shortcuts to Choices &
Roadmap for screen readers.” If you wish to include shortcuts to Choices
and Roadmap applications designed for screen readers, please select this
option. If you have JAWS installed, after copying the Choices files the
installer will ask if you would like to install the JAWS script files. These
script files aid the JAWS program in interpreting the Choices program. If
you choose to install these files, you will then be asked to locate the folder
in which JAWS is installed.

1-2-3 Career Aptitude Survey (CAS) (Optional)

The Career Aptitude Survey (CAS) is an optional resource. The CAS multi-
aptitude battery gives individuals a snapshot of their potential for specific
occupations. The CAS is fully integrated with Choices, and may only be
accessed within the Choices program.
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The CAS password is located in the Career Aptitude Survey (CAS)
Installation Guide.

Please note that you should have your CAS password on-hand as you will
be prompted to enter it. The Career Aptitude Survey (CAS) Installation
Guide is only sent if you have purchased this component.

1-2-4 eChoices (Optional and Internet based)

eChoices is an Internet-based version of Choices, which is purchased
separately. You can easily connect eChoices with your PC version of Choices
to save work and share information between Choices and eChoices. If you
have purchased eChoices you will receive a welcome letter by fax or e-mail
containing your login information for eChoices.

1-2-5 Other Products

Fore more information about other products, please visit:
u.S. http://www.bridges.com/
Canada http://www.bridges.com/canada/
Click Products on the front page.

2. Windows and Macintosh Overview
2-1 Before You Begin

Before you begin installing Choices 2004, consider the following
information:

2-1-1 View Online Technical and Browser Requirements
For information on technical and Internet browser requirements, please
view our online technical support site.

View the Tech Support pages on our Web site for technical and browser
requirements:

U.S. http://www.bridges.com/

Canada http://www.bridges.com/canada/
Click Tech Support under the Support section.

2-1-2 Please Ensure You Are Able to Run 16-Bit Applications
(Windows only)

Please ensure you are able to run 16-bit applications and that no policies
prevent 16-bit applications from running.
2-1-3 Back Up Your Data Before Installing Choices 2004

If you are installing Choices 2004 over a previous version, please back up
your data. For further information please see Section 2-2 of this installation
manual.

2-1-4 Windows-Based and Macintosh-Based
File Format — Interchanging

Windows and Macintosh session files are created in different formats and
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cannot be mixed. If you wish to transfer sessions between these two
platforms, you can use the export to eChoices option found under the File
menu in Choices (if eChoices has been purchased). Once the session has
been exported to eChoices, you may import it from eChoices on the other
platform, using the import from eChoices option found under the File menu
in Choices.

2-1-5 Should You Install Choices on a Network Server
or Standalone Workstation?
Decide if you want to install Choices on a network server or a workstation
(standalone). It is strongly recommended that you install Choices on a
server, and have all clients run Choices from that server.

If you can answer yes to any of the questions below, please complete a
Server installation of Choices:

Do you have multiple computers?

Do you want Accountability Reports compiled from one central location
at your school?

Do you want to backup session files from one central location?

Do you want to apply software updates to one central location?

Do you want to customize items in Choices for all users, such as items
listed on the Choices Start screen?

aaa gad

See Section 3 of this guide for information about different Windows
network types, or Section 12 for Macintosh network types. Some
preliminary steps must be taken to prepare your server for Choices
installation.
If you have any installation issues, please check our Web site's Tech Support
pages for FAQs and troubleshooting tips.

u.s. http://www.bridges.com/

Canada http://www.bridges.com/canada/
Click Tech Support under the Support section.

2-1-6 After Installing Choices

Access any available software updates from within Choices. Open the
System Manager and click Software Updates. This will take you directly to
the Bridges.com Web site where you can select the appropriate updates.

2-1-7 Resources Available From www.bridges.com

Many additional resources are available from the Bridges.com Web site:
u.s. http://www.bridges.com/
Canada http://www.bridges.com/canada/

Click Support on our Web site’s front page.

The Tech Support link provides information for application tips, tech
answers by product, Web browsers, and technical requirements.

Select Training Options for information about free telephone training, on-
site and regional training options.
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Select Teaching Tools for Resource Materials, such as User Guides, Access
Reference Cards for Students, Parents and Educators, and Lesson Plans.

2-1-8 Before You Begin Using Choices

Decide how you want Choices to work best for you. Several settings can be
customized to suit your specific needs.

2-1-9 Passwords — Session File Passwords are Optional

When installing Choices, you will be given the option to disable the Session
File Password feature. By default, Choices session files will require
passwords to be set up when creating a new session, however you may turn
this option on or off at any time. If you do not want new sessions to be
password protected, complete the following steps.

1. From the Choices Start screen, select System Manager.

2. Enter the System Manager password (See Section 7-2 for more
information).

3. Select Change Setup Options.

4. Select Setup Options.

5. Uncheck the box that says ‘Files require password.’

Note: Disabling this option will not remove password protection from
session files that already have passwords.

2-1-10 System Manager Password

System Manager access requires a password. See Section 7 for more
information.

2-1-11 Change The Location of the Saved Session files.

After you have installed Choices and before you begin creating Sessions, you
can decide where you would like Session files saved.
. From the Choices Start screen, select System Manager.
. Enter the System Manager password.
. Select Change Setup Options.
. Select Setup Options.
. In the section “Choose directory for Choices files” click Browse
and choose the directory in which you would like the Sessions files
to reside.

a b wnN -

Note: Users will need read and write access to this folder to use
Choices.

2-1-12 Change Location of Choices OnTrack Database

The OnTrack database contains your Accountability Reports. To change the
location of this database:

1. From the Choices Start screen, select System Manager.

2. Enter the System Manager password.

3. Select Change Setup Options.

4. Select Setup Options.
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5. In the section “Choose a directory for the Choices OnTrack database”
click Browse and choose the directory in which you would like the
OnTrack database to reside.

6. Move the ontrack.bin file to this new location.

Note: Users will need read and write access to this folder to use
Choices.

2-2 Before Installing Choices

Before you begin installing Choices 2004, please see the Bridges.com Web
page for the most up-to-date installation instructions:

u.S. http://www.bridges.com/

Canada http://www.bridges.com/canada/
Click Teaching Tools under the Support section. Click Resource Materials
for Your Product then click Choices in any of the product lists.

It is important that your network supervisor or administrator assist you with
installing and configuring Choices. If you have any questions, please see
your technician or contact our Customer Support team at 1-800-281-1168
or by e-mail at: tech-support@bridges.com.

2-2-1 Important Data Transfer Information

Please BACK UP ANY SAVED SESSION FILES (located by default in the
SESSIONS subfolder of the folder where Choices 2003 resides) before
starting to install Choices 2004.

If you have customized Choices, please print these changes and BACK UP
the ENTIRE CHOICES Folder. This provides access to your saved
information should any problems arise during the installation of Choices
2004 and the migration of data from Choices 2003. If you have any
questions regarding this process, please contact our Customer Support team
at 1-800-281-1168.

Choices 2003 allowed you to make modifications to the occupations, post-
secondary schools, local resources, Extras and Career Pathways HTML files,
letters, bulletins, and Planner files. This information from Choices 2003 will
be retained but only if you install Choices 2004 into the same folder as your
Choices 2003. You will be prompted to retain Choices 2003 customization
and user session files (Windows version only).

Before you begin your installation, have the following information available:

e The drive on which you want the program installed.

< The name of the directory or folder in which you want the program
installed.

e The components of Choices you wish to install.

2-2-2 Select One of the Following Installation Types
For Macintosh installations, please go to Section 11 Macintosh.
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For a Windows installation please select one of the following:

e For Server Installation please see Section 3 for Windows Network
Preparation.

e For a Workstation Installation please see Section 5 for a Workstation
Installation.

3. Network Preparation - Windows

There are various ways to install Choices 2004 from Windows Clients to a
Windows File Server. Below are suggestions for the most common
combinations — intended as a guide only.

Choices for Windows is installed using the InstallShield program found on
the Choices Installation CD-ROM. This program installs Choices to the
necessary folders on your hard drive and copies the files from the Choices
CD-ROM to these folders. Please read the “Before you begin” to assist you
with the following selections. Before proceeding with installing Choices,
ensure you are logged into Windows with an Administrator account.

3-1 Windows 2000 Server

3-1-1 Creating a Shared folder for the Installation

Creating Shared Install folder on Server:

e On the server create a “Choices” folder.

e Right-click the “Choices” folder and select properties. Select the Sharing

tab.

e Click Share this folder then click Permissions.

¢ By default the Everyone group has Full control. Only users with accounts
created on the server can access via the Everyone group.

3-1-2 Assigning File/Folder Permissions to the Shared
Install Folder

e Open Windows Explorer and right-click the Choices folder, click
properties. Once open, click the Security tab. Again by default, the
Everyone group has Full access.

¢ Uncheck Allow inheritable permissions from parent to propagate to this
object. Click Remove in the security warning box.

e Click Add and select the Administrators group, click OK.

e Check to give Full Control access.

¢ Now click Add and add the “Low Level Access User Group.”

e Just check Read & Execute access for the “Low Level Access User Group.”
The other two items will auto-check. Click OK.

3-1-3 Create Mapping (On Windows Clients)

Choices and the installer program do not support the Universal Naming
Convention (UNC). Therefore, you need to use a drive letter in order to run
Choices or the installer. See section 4-2 Mapping to Network Drive.
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NOW INSTALL THE CHOICES 2004 PRODUCT TO THE SHARE. This can
be done from a client through the mapped drive to a server using the
“Server” install method or locally at the server. Once installed, the remaining
client workstations can have a shortcut created on their desktop.

Note: If the client is running Windows XP please refer to section 4-1.
You must install to the server from the client using the “Server”
method as detailed section 4-1.

3-1-4 Giving Full Access to the OnTrack and Sessions Folder.
e Open the Choices folder.
e Right click the OnTrack Folder and select the Security tab.
e Select “Low Level Access User Group” and give Full access.
¢ Do the same with the Sessions folder.

3-2 Windows NT4 Server

12

3-2-1 Creating a Shared Folder for the Installation

e On the server create a “Choices” folder.

e Right-click the Choices folder and select properties. Select
the Sharing tab.

o Select Shared As: then click Permissions.

¢ By default, the Everyone group has Full control. Only users with accounts
created on the server can access via the Everyone group.

3-2-2 Assigning File/Folder Permissions to the Shared
Install Folder

e Within Windows Explorer right-click the Choices folder and click
properties. Once open, click the Security tab. By default, the Everyone
group has Full access. Now click Permissions.

e Remove the Default Everyone group.

e Uncheck Replace Permissions on Subdirectories.

e Click Add and select the Administrators group, then click OK.

e Check Full Control.

e Now click Add and add the “Low Level Access User Group.”

e Check Read access for the “Low Level Access User Group.” Click Yes to
“Warning, this will affect all subdirectories.”

e Click OK to complete access to the folder.

3-2-3 Create Mapping (On Windows Clients)
Choices and the installer program do not support the Universal Naming

Convention (UNC). Therefore, you need to use a drive letter to run Choices
or the installer. See Section 4-2 Mapping to Network Drive.

INSTALL CHOICES 2004 TO THE SHARED FOLDER. This can be done
from a client to a server using the “Server” install method, or locally at the
server. Once installed, the remaining client workstations can have a shortcut
created on their desktop.
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3-2-4 Giving Full Access to the OnTrack and Sessions Folder.
e Right-click the OnTrack folder and select the Security tab.
e Select Low Level Access User Group and select Permissions. Choose Full
Control from the Type of Access dropdown list. Click OK to finish.
¢ Do the same with the Sessions folder.

3-4 Novell Networks

Note: Ensure the Novell client is at least: 4.83(SP1) for Windows
NT/2000/XP and 3.32(SP1) for Windows 95/98/ME.

3-4-1 Creating a Shared folder for the Installation

Creating Shared Install folder on Server
¢ On the server create a “Choices” folder.

3-4-2 Assigning File/Folder Permissions to the Shared Install
Folder
e Right-click the Choices folder and select properties. Select the NetWare

Rights tab.
e Give Read and Execute rights for the “Low Level Access User Group.”

3-4-3 Create Mapping (On Windows Clients)

Choices and the installer program do not support the Universal Naming
Convention (UNC). Therefore, you need to use a drive letter in order to run
Choices or the installer. See Section 4-2 Mapping to Network Drive.

INSTALL CHOICES 2004 TO THE SHARED FOLDER. This can be done
from a client to a server using the “Server” install method, or locally at the
server. Once installed, the remaining client workstations can have a shortcut
created on their desktop.

3-5 Post-Installation of Choices

3-5-1 Giving Full Access to the OnTrack and Sessions Folder.
(Windows-Based)

e Right-click the OnTrack folder and select the Security tab.
e Select Low Level Access User Group and select Permissions. Click Full
Control from the Type of Access dropdown list. Click OK to finish.
e Do the same with the Sessions folder.
3-5-2 Giving Full Access to the OnTrack and Sessions folder.
(Novell-Based)

¢ From the Novell Client workstation, right-click the OnTrack folder and
select the Netware Rights tab.

o Select Low Level Access User Group and give full rights [R,W, C, E, M, F]
(Read, Write, Create, Erase, Modify, File Scan).

¢ Do the same with the Sessions folder.
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4. Running Choices 2004 from a server —

Windows

4-1 Windows XP Professional Clients Connecting to

Windows-Based Servers

On the Windows XP client, log in as Administrator with same login
credentials as the Windows Server Administrator account. The following
steps are only required the first time Choices 2004 is installed onto the
server. Once installed, all remaining Windows XP clients can have a
shortcut created on their desktop as described below.

4-2 Mapping to Network Drive

¢ Double-click My Computer on the Windows desktop.

¢ From the Tools menu select Map Network Drive.

e Click Browse to locate the server's shared Choices folder. Click Finish.
The network drive you have mapped should be visible in the My
Computer list.

4-3 Windows 98 Clients and Windows Server

This assumes Choices 2004 has already been installed on a server, the

folders have been installed, and permissions set while logged on as a

member of the “Low Level Access User Group.”

To create a shortcut on the workstation desktop:

e Double-click Network Neighborhood on your desktop.

¢ Locate the network server containing the shared Choices folder. Right-
click the Shared folder and select Map Network Drive.

e Select Reconnect at logon and click OK.

¢ The network drive you have mapped should be visible in the My
Computer list.

e Open Windows Explorer, open the mapped drive and navigate to the
wchoices.exe file inside the \Choices\Apps folder.

¢ Right-click wchoices.exe, select Send To and choose Desktop. A shortcut
will be created on the desktop.

¢ Change the shortcut name to Choices 2004

4-4 Windows 2000 Professional Clients and Windows

14

Server

This assumes Choices 2004 has already been installed on a server, the

folders have been installed and permissions set, while logged on as a

member of the “Low Level Access User Group.”

To create a shortcut on the workstation desktop:

e Double-click My Computer on the Windows desktop. From the Tools
menu select Map Network Drive.
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e Click Browse to locate the server's shared Choices folder. Click Finish. The
network drive you have mapped should be visible in the My Computer
list.

e Open My Computer on the Windows desktop. Right-click the local hard
drive (C:) and choose Explore.

e Under Documents and Settings choose the “user” account (a member of
the “Low Level Access User Group”) and then the desktop folder. Note:
you can install the Choices 2004 Shortcut on every user’s desktop by
creating the Shortcut in the “All Users” desktop folder.

¢ Now right-click the right-hand pane and select New then choose Shortcut.

e Click Browse, then browse to mapped drive and find the wchoices file in
the \Choices\Apps folder. Click OK.

¢ Click Next. Change the desktop shortcut name from wchoices.exe to
Choices 2004. Click Finish.

4-5 Windows Clients Connecting Novell Netware-
Based Servers

Note: Ensure the Novell client is at least 4.83(SP1) for Windows
NT/2000/XP or 3.32(SP1) for Windows 95/98/ME.

For a Windows XP Client, log in as Administrator with same login
credentials as the Netware Server Administrator account.

4-5-1 Mapping to Network Drive

e Double-click My Network Places, double-click Novell Connections.

e Double-click the server icon, double-click the volume containing the
Choices folder.

e Right-click the Choices folder and then click Novell Map Network Drive

e Select the drive letter. Ensure that “make folder appear as the top most
level” and “Always map the drive letter when you start windows” are
checked.

e The network drive you have mapped should be visible in the My
Computer list.

4-5-2 Creating a Shortcut on the Workstation Desktop.

e Open My Computer, right-click the local hard drive (C:) and choose
Explore.

e Under “Documents and Settings” choose the “user” account (a member of
the “Low Level Access User Group”) and then select the desktop folder.
Note: you can install the Choices 2004 Shortcut on every user’s desktop
by creating the shortcut in the “All Users” desktop folder.

e Right-click the right-hand pane and select New, then select Shortcut.

e Click Browse and navigate to your mapped drive. Locate the wchoices.exe
file in the \Choices\Apps folder. Click OK

¢ Click Next. Change the desktop shortcut name to Choices 2004. Click
Finish.
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4-5-3 Windows 98 Clients and Netware Server

Creating a shortcut on the workstation desktop.

e Double-click Network Neighborhood on your desktop.

e Find the Network server in which the Choices 2004 software is installed.
Double-click to show the shared folders available on the server.

e Right-click the Shared Choices folder and select Map Network Drive.

e Select Reconnect at logon and click OK.

e The network drive you have mapped should be visible in the My
Computer list.

e Open Windows Explorer, open the mapped drive and browse to the
wchoices.exe file inside the \Choices\Apps folder.

e Right-click wchoices.exe, then choose Send To and select Desktop. A
shortcut will be created on the desktop.

e Change the shortcut name to Choices 2004

4-5-4 Windows 2000 Professional Clients and Netware Server

Creating a shortcut on the workstation desktop.

e Open My Computer. Choose the Tools menu and click Map Network
Drive. Select Browse.

e Browse to the shared install folder on the Windows Server, then click
Finish.

e Open My Computer, right-click the local hard drive(C:) and choose
Explore.

e Under “Documents and Settings” choose the “user” account (a member of
the “Low Level Access User Group”) and then the desktop folder. Note:
you can install the Choices 2004 Shortcut on every user’s desktop by
creating the Shortcut in the “All Users” desktop folder.

e Right-click the right-hand pane and select New, then select Shortcut.

e Click Browse, then browse to mapped drive and find the wchoices.exe file
in the \Choices\Apps folder. Click OK.

e Click Next. Change the desktop shortcut name from wchoices to Choices
2004. Click Finish.

5.Workstation (Stand-alone) or

Server (Network) Installation

To complete a Workstation (stand-alone) or Server (network) Installation, it
is important that your network supervisor/administrator assist you with
installing and configuring Choices. If you have any questions, please see
your technician or contact our Customer Support team at 1-800-281-1168
or by e-mail at tech-support@bridges.com. Please read Section 2-1 Before
you Begin.

5-1 To Install Choices from the CD-ROM

Insert the Choices 2004 Installation CD into your CD-ROM drive. If the
installer does not start automatically, then proceed with the following
instructions.
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a. Choose Run from the Start menu.

b. Type: x:\setup where “X” is the letter that corresponds to your CD-ROM
drive. Click OK.

c. Click Next on the Choices 2004 welcome screen.

d. The Bridges.com license agreement will now be displayed. You can
choose | Accept or | Do Not Accept. However, to continue with the
installation, you must click | Accept.

e. You will be prompted to select whether you will be installing Choices to a
Workstation or a Server. If you are installing to a workstation, the Choices
2004 Program Group and icons will automatically be created. If you are
installing Choices to a server, please refer to Section 4 for information on
creating a shortcut on the workstation desktop. Click Next.

f. Click the Choices button.

g. You may choose one of two initial configurations for Choices either High
School Student or Adult/Post-Secondary Student. Click Next.

h. Follow the instructions on your screen.

5-2 Career Videos Installation

Career videos are now Internet-based and will be automatically installed
with your Choices software.

5-3 Career Aptitude Survey (CAS) Installation
(Optional)

The Career Aptitude Survey (CAS) is an optional assessment that can be
added to Choices (if it has been purchased).

To add the CAS as an assessment in Choices, please select the Career
Aptitude Survey when prompted during the Choices installation process.
Refer to the Career Aptitude Survey (CAS) Insert for the password and enter
the password when prompted.

6. Removing Choices
6-1 Removal of Choices 2003

Prior to removing Choices 2003, please make a back-up copy of any
saved sessions you wish to keep (located by default in the SESSIONS

subfolder of the folder where Choices 2003 resides). Also make back-up
copies of any customized pages or modifications to occupations, post-
secondary schools, local resources, Extras and Career Pathways HTML files,
letters, bulletins, and Planner files you have created. This provides access to
your saved information should any problems arise during the installation of
Choices 2004 and the carrying-over of data from Choices 2003.

Choices 2003 can be removed by installing Choices 2004 into the same
folder where Choices 2003 is installed. This will overwrite your Choices
2003.

OR
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1. Go to Windows Explorer.

2. Locate the Choices folder on the drive where it has been installed.
3. Select the Choices folder.

4. Choose Delete from the File menu.

6-2 Removal of Choices 2004

Prior to removal, please make a back-up copy of any saved sessions you
wish to keep (located by default in the SESSIONS subfolder of the folder

where Choices 2004 resides) as well as any customized pages or
modifications to occupations, post-secondary schools, local resources, Extras
and Career Pathways HTML files, letters, bulletins, and Planner files which
you have created. This provides access to your saved information should
any problems arise.

1. Go to Windows Explorer.

2. Locate the Choices folder on the drive where it has been installed.

3. Select the Choices folder.

4. Choose Delete from the File menu.

7. System Manager (Choices Administration) -
Windows
7-1 About the System Manager

The System Manager contains resources to customize Choices and view
accountability reports. To launch the System Manager, click on System
Manager from the Choices Start screen.

7-2 The System Manager Requires a Password

The System Manager requires a password.

If the password has been changed please call Customer Support at 1-800-
281-1168 or e-mail tech-support@bridges.com for steps on how to override
this password.

7-3 System Manager Change Setup Options - Windows

7-3-1 Change Setup Options
Change Setup Options allows you to: change the System Manager password,;
change the Session Files Master Password; change the default directory for
the Session Files; change or enter a Site Name; and select the server running
the time service to get the current date.

7-3-2 Customize the Databases

Customize the Databases allows you to choose the topics that are available
for searching the Choices databases or disable the search function; choose
the topics displayed on the Choices information reports.

7-3-3 Customize the Start Screen

Customize the Start Screen allows you to add or remove items from the
Choices start screen.
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7-3-4 Customize the Planner

Customize the Planner allows you to customize the Planner menu to offer
the appropriate modules to users; change the suggested activities in the
Post-secondary Plans module; customize the topics in the Challenges
module.

7-3-5 Create Sample Letters

Create Sample Letters allows you to create or edit the sample letters that
users can personalize or print in Choices.

7-3-6 Edit Local Information
Edit Local Information allows you to create or edit local information
associated with items in the Choices databases, including the Local
Resources database.

7-3-7 Edit Course Plans

Edit Course Plans allows you to change the four-year course plans shown in
the Choices occupations reports.

7-3-8 Extras! Pages

Extras! Pages allows you to change the Extras Pages for any of the databases:
Post-Secondary Schools, Financial Aid, Graduate Schools or Occupations.

7-3-9 Accountability Reports

Accountability Reports allows you to track Choices usage for individuals or
groups of users using OnTrack.

7-3-10 Choices News Pages

Choices News Pages section allows you disable or edit the front or back
News Page.

When Choices 2004 launches, you will see a news bulletin on your screen.
This bulletin contains information on the updates that have been made to
the Choices program. You can edit this text to display information relevant
to your site or you can shut off the feature entirely.

To change the bulletin messages back to their original format, delete the
existing openbull.htm or closbull.htm files. Then rename either the
openbull.bkp or closbull.bkp file to openbull.htm or closbull.htm. These
files are found in the Choices/Common subfolder.

7-3-11 Software Updates

Software Updates allows you to browse available software downloads for
Choices on the Bridges.com Web site. To access this information go directly
to:

U.S. http://www.bridges.com/

Canada http://www.bridges.com/canada/
Click Product Updates under the Support section.
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7-4 Other Customizations

7-4-1 Planner Logo

When you print the Personal Information module of the Planner, a
Bridges.com logo appears on the cover page. You can replace this logo with
your own artwork or logo. The file to replace is called PERSLOGO.BMP and
is located in the CHOICES folder in the COMMON subfolder.

The file you use in its place must have the following attributes: width = 305
pixels, height = 150 pixels, depth = any depth, and type = BMP file. Simply
rename your file, matching the above requirements, to PERSLOGO.BMP and
save it into the COMMON subfolder, replacing the existing file. We suggest
that you keep a copy of the original file should you wish to return to the
original logo.

7-4-2 Report Topic Information

Report Topic Information can be customized. Information for Suggested
High School Subjects and Regional or Provincial Graduation Requirements
(for Canada only) is available in the occupation reports. If these features are
not active in your version of Choices 2004 and you would like to activate
them, go to the System Manager (you will be prompted for the password)
and select Customize the Databases. Click Report Topics and choose
Occupations database. Scroll down the list and select the option(s) you
require, then click OK.

7-4-3 Career Area Interest Checklist (CAIC)

To enable the Career Area Interest Checklist on the Start screen, go to the
System Manager and select Customize the Start Screen. Select Career Area
Checklist and click OK.

Choices is shipped with the Career Areas occupation search and report
topics disabled. If you wish to enable the topic, go to the System Manager
and select Customize the Database. Select Search Topic and Options, then
Occupations, select Career Areas, and click OK. Now select Report Topics,
then Occupations, select Career Areas and GOE, and click OK.

7-4-4 Work Preference Checklist (Canada Only):

Choices is shipped with the Work Preferences occupation search and report
topics disabled. If you wish to enable the topic, go to the System Manager,
select Customize the Databases. Select Search Topic and Options, then
Occupations, select Work Preferences, and click OK. Now select Report
Topics, then Occupations, select Work Preferences, and click OK.

7-5 Web Browser and Internet Features
7-5-1 E-mail Access

Choices allows users to e-mail letters directly to post-secondary or graduate
schools from the program. In order to do this, the config.ini file in the
COMMON subfolder must be modified to include your mail server address.
If you are unsure of this address, please contact your Internet/network
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technician or your Internet provider. To edit your mail server address:

1. Locate the Choices folder on the drive where it has been installed.

2. Open the Common\config.ini file.

3. In the file, locate the [Mail] section and enter your mail server out
address in the Server= line.

If you are unsure how to complete this procedure, please contact your site

administrator or our Customer Support team at 1-800-281-1168.

7-5-2 Changing your Internet Browser/Modifying
Internet Access

During the installation process, you were prompted to choose one of three
Web browsers: the Choices built-in Web browser, Netscape Navigator, or
Internet Explorer. It is recommended that you use Netscape Navigator or
Internet Explorer to ensure compatibility with Web pages.

The following instructions will overwrite the setup for all users running

Choices from the network, except for those who have changed the setup

using the Select Web browser feature below. It is possible to reverse the

original decision in one of two ways:

1. Locate the Choices folder on the drive where it has been installed.

2. Open the Common\config.ini file.

3. In the file, locate Web browser Information section.

4. Edit WebBrowser= line using either O for the Choices built-in Web
browser, 1 for Internet Explorer, or 2 for Netscape Navigator.

5. Choose Save from the File menu.

OR

*The following instructions will overwrite the setup for the current

workstation.

1. Choose File on the Choices menu bar.

2. Choose Select Web browser.

3. Enter your System Manager password.

4. Select the Web browser you wish to use.

5. Click OK.

* For more information on our Internet features, please contact our

Customer Support team at 1-800-281-1168 or by e-mail at tech-

support@bridges.com.

8. Installing Adobe Acrobat Reader - Windows

To download Adobe Acrobat go to: http://www.adobe.com and click on
Support>Downloads>Adobe Reader>Windows.

9. Running the Choices Application - Windows
9-1 How to Run the Choices Application

* Click the Choices short cut on your desktop, or
* Click Start, choose Programs and select Choices 2004, or
* Open My Computer, locate the Choices/Apps folder, and double-click the
WChoices.exe file.
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9-2 Choices Session Files

Choices Session files will have the extension CHS added automatically. By
default the Session files will be saved to the Choices/Sessions folder. This
path can be changed in the System Manager. Password protection of the
Choices Session files can be turned on or off in the System Manager.

When saving, please remember that file names MUST NOT contain the
following characters: /2\<>;:*#".

10. Macintosh
10-1 Before you begin

Please see Sections 1 and 2 for product information and installation
information.

10-2 Important Data Transfer Information

Please make a back-up copy of any saved sessions (located by default in
the SESSIONS subfolder of the folder where Choices 2003 resides) before

starting to install Choices 2004.

NOTE: Research information, modifications to occupations, post-secondary
schools, local resources, Extras and Career Pathways HTML files, letters,
bulletins, and Planner files entered in Choices 2003 that you may have
saved, are not automatically transferred. If you would like to retain this
information for use in Choices 2004, please contact our Customer Support
team at 1-800-281-1168 for the necessary instructions. Choices 2004 will
be installed in a different folder than Choices 2003. To avoid possible
confusion and to conserve disk space, we recommend that you remove
Choices 2003 from your hard drive after saving any modifications noted in
the previous paragraph.

| 1. Network Installation Notes — Macintosh

There are varying combinations of installing and running Choices 2004
from Macintosh Clients to Windows Based Servers. The following
suggestions for the most common combinations are intended as a guide
only.

I 1-1 Installation of Choices - Windows Server-Based

I1-1-1 Macintosh Clients on Windows 2000 Server

Configuring Macintosh Sharing Rights and File/Folder Permissions

e Log on to the server as administrator and ensure the Macintosh Services
for Windows have been installed.

e Go to Start, select Administrative Tools then choose Computer
Management. Double-click Shared Folders, right-click Shares folder and
select New File Share.
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» Browse to the Application folder on the server hard drive. Fill out the
Share Name (Windows) and the Macintosh Share Name. Check Apple
Macintosh client. Click Next.

o Select either All users have full control for the share or Customize share
and folder permissions depending on the site's security. Click Finish.

¢ Click No. Another share does not need to be created. Now go to the
Macintosh to see the share.

I 1-1-2 Macintosh Clients on Windows NT4 Server

Configuring Macintosh Sharing Rights and File/Folder Permissions.

e Log on to the server as administrator and ensure the Macintosh Services
for Windows has already been installed.

e Go to Start, select Administrative Tools then choose File Manager.

e Create a folder that will be the Share point for the Macintosh clients.
Select the folder you want to share (from the toolbar). From within File
Manager select MacFile and then Create Volume.

e The Create Macintosh-Accessible Volume box will appear. Click
Permissions. Click the “[...]” box by the Primary group input field. This
will open the Primary Group list of users. Select the “Low Level Access
User Group” then add the group as the Primary Group. Note: the owner is
the Administrators group. Once the “Low Level Access User Group” has
been selected click OK.

e Give full “Share” access permissions to the new Primary Group by
checking See Files, See Folders and Make Changes. Click OK. Again, click
OK. A warning message may appear, as the volume you are creating may
be greater than 2 GB. Just click Yes, as this problem affects only to older
Macintosh operating systems.

e Click OK to complete the procedure. The File and Folder permissions for
Windows NT 4 can be configured depending on the site's security. See
Section 3-2.

¢ Now go to your Macintosh to see the share.

I 1-1-3 Running Choices From a Macintosh Client Connected
to a Windows Based Server

Ensure on the Windows Server that a shared folder has been created for the

Macintosh client to connect with.

e Select the Apple logo in the screen’s top left corner, and choose Network
Browser.

e Listed in the Network Browser window will be the Window Server.
Double-click this server icon to access.

» The server will prompt you for user authentication. Enter the account
name and password that has already been created on the Windows server
and log in.

¢ Double-click the listed server and the Windows Macintosh Shared folder
created on the server will appear. Note: A network drive shared folder
now appears on your desktop.
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» Double-click the shared folder and the contents will be displayed. At
present, the folder is empty.

e Insert the Choices 2004 CD-ROM in the CD-ROM drive and the Choices
2004 installer will start. Double-click the Choices 2004 installer icon on
the desktop to proceed with the installation.

¢ Once installation is complete, drag the Choices 2004 Installer to the
“Trash Can” — this will eject the CD-ROM.

» Double-click the Macintosh HD on the desktop.

e Double-click the Choices 2004 Folder.

o All these files need to be copied to the Network shared folder.

¢ With the Choices 2004 folder open, choose Select All from the Edit menu.
Drag all these files into the open Network shared folder.

e From the Network Server Shared Folder, select the Choices application
icon and create an alias to the desktop by holding down the Option and
Command keys, drag the icon to the desktop. Rename the alias icon from
Choices to Choices 2004.

e Check to see that Choices runs from the Macintosh clients. All the
remaining Macintosh clients can now connect to the Windows Server
Macintosh Share by creating alias (see above) on each Macintosh desktop.

I 1-1-4 Post-Installation — Server File Access Privileges

When Choices is installed on a network, the administrator must grant to
users access privileges for the various folders. The minimum set of privileges
is outlined below. Users may be granted more permission than they need as
long as this minimum set is allowed.

Folder Administrator Needs Users Need
Common See Files See Files
Make Changes
OnTrack See Files See Files
Make Changes Make Changes
*Sessions See Files See Files
Make Changes Make Changes

* 1If you do not want users to save their session files in the Sessions
subfolder, you can change this option: go to the Choices System Manager,
choose Change Setup Options. Choose Set Session Folder Location.

1 1-1-5 Macintosh Workstation (Stand Alone) Installation

1. Insert the Choices 2004 Installation CD into your CD-ROM drive. A
Choices disk icon will appear on your desktop. Double-click the icon.

2. Double-click the Choices 2004 Installer icon.

3. Click Continue on the Choices 2004 splash screen.

4. The Bridges.com license agreement will now be displayed. You can
choose to either Accept or Decline, or save the terms of the license
agreement. However, to continue with the installation, you must click
Accept.
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5. The install “Read Me” notes will be displayed. Please read through all of
the directions. You can also print these notes or save them to a file. Click
Continue to proceed.

6. The “Full National-Only” dialog will appear. This will install all of the
core components of Choices 2004. Alternately, click the arrow and
choose Custom Install if you wish to include your state information or if
you would like to remove some of the optional databases that are
installed by default.

7. A pop-up box will appear: “Which initial Choices configuration would
you like to install?” Choose either Adult or High School.

8. You will be given the option to disable password protection on new
session files, click Disable or Continue

9. Another message will appear: “Following installation, you will be
prompted to supply your site name. Once you have entered this
information, Choices will be ready for use.” Click Continue.

10. At the Choices Registration screen, enter your site name.
I 1-2 Adding Optional Products

11-2-1 Career Videos Component

Career videos are now Internet-based and will be automatically installed
with your Choices software.

11-2-2 Career Aptitude Survey Installation (CAS) (Optional)

The Career Aptitude Survey (CAS) is an optional component that can be
added to Choices if it has been purchased. For installation instructions, refer
to the CAS Installation Guide. It is only shipped if you have purchased this
component.

12. Removing Choices
12-1 Removal of Choices 2004

Please be sure to make a back-up copy of any saved sessions you wish to
keep (located by default in the Sessions subfolder of the folder where you

installed Choices 2004). If you would like to keep any customized pages or
modifications to occupations, post-secondary schools, local resources, Extras
and Career Pathways HTML files, letters, bulletins, and Planner files which
you have created, please contact our Customer Support team at 1-800-281-
1168 for the necessary instructions.

To remove all components:

1. Close the Choices 2004 folder.

2. Drag the Choices 2004 folder to the trash.

3. Choose Empty Trash from the Special menu.

4. Click OK if the remove dialog box is displayed.

5. Choices 2004 has now been removed from your hard disk.
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3. System Manager

13-

13-

13-
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(Choices Administration) - Macintosh
| About System Manager

Choices 2004 has many features, which can be customized to suit your

environment. Please read the detailed explanations of each of the features

listed below.

To launch the System Manager:

« Select the System Manger from the Start Screen or

« Browse your Macintosh hard drive and open the System Manager sub
folder in the Choices folder. Next select System Manager.

2 System Manager requires a password

The System Manager requires a password. The initial password is “setup”.
If the password has been changed please call our Customer Support team at
1-800-281-1168 or e-mail tech-support@bridges.com for steps on how to
override this password.

3 System Manager — Change Setup Options -
Macintosh

13-3-1 Change Setup Options

Change Setup Options allows you to: change the System Manager password,;
change session password settings, Choices preferences; change display; use
sessions folder to save documents, enable Internet browser access; change
default browser; display animation in report pane; display open session
dialog at startup; enable help tips; set up e-mail ; set session folder location;
and change OnTrack database settings.

13-3-2 Customize the Databases
Customize the Databases allows you to edit the search topics and report
topics used in information reports.

13-3-3 Customize the Start Screen
Customize the Start Screen allows you to add or remove items displayed on
the Choices Start Screen.

13-3-4 Customize the Planner
Customize the Planner allows you to edit the Modules on the Planner Menu;
Edit the Post-Secondary Plans Module and the Challenge Module or change
the text displayed in these areas.

13-3-5 Create Sample Letters

Create Sample Letters allows you to create or edit the sample letters that
users can personalize or print in Choices.
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13-3-6 Edit Local Information
Edit the Local Information section in the following Databases: Occupations,
Post Secondary School, Graduate Schools, Financial Aid or Local Resources.
13-3-7 Edit Course Plans
Edit the Course Plans allows you to change the four-year course plans
shown in the Choices occupations reports. This section will edit the text
listed in Course Plans (Career Pathways).
13-3-8 Extra! Pages
Extra Resource allows you to edit the Extras! Pages for any of the databases:
Post-Secondary Schools, Financial Aid, Graduate Schools or Occupations.
13-3-9 Accountability Reports
Accountability Reports allows you to track Choices usage for individuals or
groups of users using OnTrack.
13-3-10 Create News Pages
Choices News Pages section allows you disable or edit the front or back
News Page.

When Choices 2004 launches, you will see a news bulletin on your screen.
This bulletin contains information on the updates that have been made to
the Choices program. You can edit this text to display information relevant
to your site or you can shut off the feature entirely.

13-3-11 Software Updates

Software Updates allows you to browse available software downloads for
Choices on the Bridges.com Web site. To access this information go to:
U.S. http://www.bridges.com/
Canada http://www.bridges.com/canada/
Click Product Updates under Support on our Web site’s front page.

14. Other Resources = Windows & Macintosh

14-1 Installing Software Updates

Software Updates allows you to see if any Product Updates are available on
the Bridges.com Web site.

14-2 Accountability Reports

Accountability Reports allows you to create Accountability Reports for
Choices usage for individuals and groups of users.

14-3 Bridges To Career Lesson Plans (BTC) (U.S. Only)

Bridges-to-Careers offers flexible activities that feature career development
concepts and integrate academic and vocational skill building. Grade-level
lessons target self-assessment, career exploration and planning. This year
you can access these activities through Choices.

Bridges.com Choices 2004 Installation Guide 27



To access the Bridges-to-Careers activities, click Support and Resource
Materials on the Choices start screen. Click on Bridges-to-Careers Lessons
to open a Web page where you can select and print the activities of your
choice.

A User Reference Guide is also available to help you use Bridges-to-Careers.
The guide shows how lessons align to National Career Development
Guidelines and SCANS (Secretary’s Commission on Achieving Necessary
Skills) and other helpful information. To view the Bridges-to-Careers PDF
files you need Adobe Acrobat Reader installed on your computer. If you do
not have Adobe Acrobat Reader installed on your computer, refer to Section
8 for Windows or Section 17 for Macintosh for instructions on how to
install it from your Choices Installation CD.

14-4 Printable Resource Materials

For printable resource materials to help you use Choices, click on Support
and Resource Materials on the Choices Start screen or visit
www.bridges.com:
u.S. http://www.bridges.com/
Canada http://www.bridges.com/canada/
Click Support>Teaching Tools>Resource Materials for your product. Click
on Choices from any of the lists. Bookmark this URL for future reference.

14-5 Bridges National Training Institute

The Bridges National Training Institute provides a range of options to help
you achieve your goals using our products. These include no-charge
teleconference sessions, comprehensive on-site workshops and standards-
based curriculum training.

Join the thousands of educators from across North America who take part in
Bridges training sessions. For more information visit:

u.S. http://www.bridges.com/

Canada http://www.bridges.com/canada/
Click Training Options under the Support section.

14-6 Professional Manual

28

The Professional Manual: explains the rationale, theory, and philosophy
behind the development of Choices; provides an explanation of the topics
and factors available and tips for their effective use; and provides access
strategies for using and implementing Choices. To access the Professional
Manual click Support and Resource Material on the Choices Start screen
then click Complete Professional Manual.
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15. Installing Adobe Acrobat Reader -
Macintosh

To download Adobe Acrobat go to: http://www.adobe.com and click
Support>Downloads>Adobe Reader>Macintosh

16. Running the Choices Application - Macintosh
16-1 How to Run the Choices Application

Open the Macintosh hard drive and browse the Choices 2004 folder, and
double-click the Choices file.

16-2 Choices Session Files

By default the Session files will be saved to the Choices/Sessions folder.
This path can be changed in the System Manager. Password protection of
the Choices Session files can be turned on or off in the System Manager.

When saving, please remember that file names MUST NOT contain the
following characters: /2\<>;:*#".
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